Getting low-resolution GC-MS data on the JEOL GCMate

Introduction

GC-MS is a technique that combines gas phase separation and mass-based detection/characterization of analytes. It's a very sensitive method
that is limited to reasonably volatile compounds that are thermally stable. Compounds that readily form hydrogen bonds with themselves (e.g.
amides and carboxylic acids) are especially poor candidates for GC-MS analysis in their native form. However, even highly polar compounds,
such as carbohydrates or peptides can be made suitable for GC analysis by derivatization. Ask us if you want more info.

Separation of analytes is achieved by controlled heating of the column in the GC oven. In a typical temperature program the oven is heated to an
initial set point and that temperature is maintained for a few minutes to drive the solvent off the column. The oven temperature is then heated up
(ramped) to a final temperature causing the analytes to advance on the column and separating them based on their volatility. The final
temperature is typically held for a period of time to ensure all analytes are driven off the column. You control the heating and thus separation by
selecting an appropriate inlet procedure when setting up your experiments.

Detection of analytes is accomplished by repeatedly scanning through the desired mass (or more precisely mass to charge ratio, m/z) range
during the inlet program and counting the number of ions that hit the detector. Adding up all ions generates the total ion chromatogram (TIC).

In your lab

To minimize chemical contamination in the MS room you MUST transfer your sample into the autosampler vial in your

own lab and you MUST label all vials with your name!
For low resolution MS you should make a up a solution of your compound in any solvent you'd like as long as that solvent’s boiling point is
significantly less than the boiling point of your analyte. The concentration should be around 0.1 mg/ml for the standard GC programs. If you can’t
weigh your compound accurately err on the side of too little sample rather than too much. You will only need 0.5-1 ml of sample, so don't dissolve
10 mg in 100 ml of solvent! It's a waste of compound and solvent. Use successive dilutions if you need to (if you don’'t know what “successive
dilution” means ask us and we’ll explain). Place 0.5-1 ml of your sample in an autosampler vial and seal it with a septum cap. The color of the cap
doesn’t matter. You may pick up vials from the MS room (B-22) or Tony’s office. Feel free to pick up a few extra for future samples or you can also
order your own if you desire. Please let us know if the vials or caps are running low!

In the GC-MS room

Optional: To purge accumulated gunk from the GC column, on the GC keypad press [OVEN TEMP] [3] [0] t?:;“p' Injector tower
[0] [OK] to heat the oven up to 300°C. The oven will cool down automatically when you start your \

acquisition.

Insert your sample into an open position on the sample tray of the autosampler. The tray has four
removable quadrants (Q1-Q4 in diagram). The position numbers increase from the inside to the outside
and counter-clockwise around the tray. Determine the positions based on the diagram and do NOT trust
the numbers printed on the quadrants! They are removable and someone may have put them back in
the wrong position, i.e. the quadrant closest to you is always positions 1-25 even if the plastic has 75-99

You stand here!
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printed on it. Note the position of your sample and enter the appropriate information in the logbook and the white board mounted on the wall
(coming soon).

Check the solvent level in wash bottle Al (position 12) and B1 (position 8) in the small carousel mounted directly on the injector tower of the
autosampler. If the level is at or below the “minimum solvent level” mark, fill wash A with methanol and wash B with hexane from the solvent
bottles standing next to the GC. Pipettes and bulbs should be on the prep table and please let us know if we they are running low. You may now
sit in front of the computer.

At the computer

If nobody is logged in, log in as user “Ilvan Keresztes” with the password Kersztes (notice missing ‘e’). Do NOT log in as gcms.
If somebody is already logged in

1. Somebody is logged in and the instrument is idle, or

2. Somebody is logged in and the instrument is running a sample.
You should see a window that looks like this:

il GCmatePro 3.0 - Launch Pad E

] [ = =L
4 I h; JS0L
ET O TH # o
InstCont |DataRed | System | Bugs | AutoRep| Update | 1S0L32

Right click for popup menu B/24/2006 | 10:01 P

(If you don't see Launch Pad click Start Menu - All Programs - TSS Pro 3 - Launchpad.) The first button starts “instrument control” which is
equivalent to data acquisition. The second button starts “data reduction” which is mass-spec-speak for data processing. You will never use any of
the other buttons.
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GCmatePro 3.0 - Instrument Control

File winNga Calbration Source Peak Printing Help
£ uls
AORA i B @ LA
Tune Mode AIM Mode  Scan Mode  MSProc  Active Files Inlets DataRed

o TmE O - D00 Ay IN-<% ®

lon Sourca] lon Fncusingw SI\tSettingsl Detectorl Inlalsl

Mass Selection

Mass R i
ass Fange Accelerating Yolts

Start “Instrument Control” by clicking the InstCont icon. o Eom
You should get a window that looks like this:

| TUNE

Make sure the “Tune Mode” button is depressed on the Ture Masses
graphical menubar.

23
283 | 100
< I |
Profile "window  +[ppm|
3600 [ Auto
]
Open Tune Setup File En
Look jn: |L'f) System j ¢ S il
\ 35-500-EI-pos-pFk.stp
4 CI-neg-pfk.stp
CI-pos.stp
ClPasitive, STP

EI_default.5TP
El+_18eV.stp
El+_20eV.stp
ElPasitive. 5TP
ElPositive_20,5tp
EI-pos-pfhk.stp
LOAD_ME_HR..stp
LOAD,

Click File->Open File...
The file open dialogue appears.
Select LOAD_ME_LR from the list.

L)

R

File name: |LOAD_ME_LR -] gpen |
Files of type: |Instrument Set-up Files j Cancel
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GCmatePro 3.0 - Instrument Control

File MWindow Calibration Source Peak Printing Help

A M B

Press the green Play bUtton: TuneMode SIMMode ScanMode M5 Prog
a4 f+ /_ ) [E3 H ﬂ

i 9 @

Inlets DataRed
o) s
0Fv-IR-e% @

lon Suurce] lon Fucusing\ S\itSellingsl Deleclurl \nlelsl

o
Active Files

o

Mass Selection I |

GCmatePro 3.0 - Instrument Control

File ‘Window Calibration Source Peak Prinkting Help

iy = & [ @2 &

Inlets DataRed

}}LPLfam B i |Ey -S| @

lon Sounce ] lon
tass Selection l
Accelerating Yolts

Click the “Mass Selection” tab... e ET
...then select 281 from the “Tune Masses” list by single

Fesolution = 1100
usiﬂg\ S\ilSell\ngs\ Detecturl Inlets}

clicking it. (If you accidently double clicked it just click | TONE
“Cancel” in the window that pops up.) Tune Masses

You should see a single peak somewhere in the Moz [zinen ]
window. If you don't, find lvan or Tony.

Profile \Window  [ppm]
3itppr E

[251
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&z GCmatePro 3.0 - Instrument Control

File Window Calibration Source Peak Printing Help

Inlets

¥ o Lmm B ) 000 My

Resolution= 1100

\.?‘-‘ @

Slit Settings l Detectorl Inlets l

lon Source ] lon o
Maszs Selection ]

& 100 ~ oo Accelerating Yol

1500 ¢ 3000 2400

The peak will probably be off-center. Double click the
top of the peak to center it. I TURE
Click the “wizard’s wand” icon to start the automatic Tune Masses
tuning routine.

13 100

18 it}

219 30

261 mJ

293 100

w0

Profile \Window  +[ppm)
S600ppm 3600 [~ Auta
281
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=z GCmatePro 3.0 - Instrument Control

File ‘Window Calibration Source Peak Printing Help

& T =" [l
Tuneﬂﬁade SIMAl‘ﬁ’:“ode Sca||1I|II\!II0de MSPlj:c Actﬁiiles Re[arl:r
r} | )'/5;) }"/_:_) é ‘ J LJ] I At Tune Options——————————————————
i Al
= Fepeler
= Accel Yolt Fine Ietsl
= Foous _’I
) . " Deflectar
A new window pops up and the display goes blank. P |
At the very bottom of the Instrument Control window you N
will see a message saying “Waiting for signal to % Confim
stabilize” or “Autotune in progress”. I~ Pint Repost on Completon ™
2
Stop halts Auto Tune and retains current settings. _’I
ol
rse
] Load Focus I
I Stop Cancel |

| —

Low-resolution GC-MS on JEOL GCMate Page 6 of 11 Cornell University Chemistry MS facility



When Auto Tune is done it will display the new and old
peak shapes. If the new one looks better than or the
same as the old (which should almost always be the
case) click the OK button in the Auto Tune window.

If the new peak shape looks worse than the old one,
please tell Ivan or Tony, because something is wrong
with the instrument.

Click the red “stop” button.

Click the “MS Proc” button.
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&2 GCmatePro 3.0 - Instrument Control

T 9

Auto Tune Results

3| @ @ Y i .
LK o h J ‘—] n ‘ Parameter Dld] Nesw
Mew old Repeller 8205 2075
Mas: Accel Vol Fine 0052 -0016
lon Soi First Focus .6a53 .6954
Second Focus .rooz 63745
Deflector Upper 0372 0295
Fet | | Defiector Lower 03795 oans| | 2
A Q3 Lens 53203 HE44E ﬂ
Firs! ’
e [+ Confirm J
Sec [~ Prirt Report on Completion j
Def |
Dflen
Def AutoTune completed j
03 ol

o
a
=
&

Relo
—~—

281

AutoTune completed

= GCmatePro 3.0 - Instrument Control

File Window Calbration Source Peak Printing Help

i) 19 Go9om

Inlets DataRed

Veoremige ooy S 0@
B = a4

Ez GCmatePro 3.0 - Instrument Control

File ‘Window Calibration Source

EXRT

Tune Mode  SIMMode  Scan Mad

ting Help

L @ @

Active Files Inlets DataRed
) 0D0 M- N2 @

lon EEUIDE] lon Fncusing} S\itSettingsl Dete:lnrl \nlels]

Mass Selzction
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In the unlikely event that a pop up window opens with a
list of calibration files select 35-500-03-B.cal and click
Open. Otherwise ignore this step!

Click File>Open File

Select GC_35-500-LR_10min.MSM from the list
regardless of what you are doing later.

[The purpose of this step is to make sure you have all
the relevant settings available to you when you set up
your GC-MS experiments. If the last person did direct
probe work or did not use the autosampler, some
settings would be grayed out.]

Low-resolution GC-MS on JEOL GCMate

Open Calibration File

Look jn: | 7 System

<

35-500-15ec-B.cal Linlsec,cal

35-500-03sec_18ev-B.cal | pfkl0sec.cal

35-500-03sec_z0ev-B.cal [[H] SCAN.CAL
0-0 cal

100-180-04sec-Hv, cal

120-600-15ec-B.cal

120-855-15ec-B.cal

120-1150-15ec-E.cal

150-290-04sec-Hy, cal

210-390-1sec-HY,cal

210-390-04sec-Hy. cal

300-500-04sec-H. cal

300-600-152c-HY, cal

EXP15EC, CAL

JUMEC,CAL

File name: |36-600-03sec-E

Files of bype: |Calibration Files

j Open |
j Cancel

Open MS Procedure

Look jh: | I System

Sl 08 e m

chem303.msm
DIP_35-500-LR-10rmin, msm
DIP_120-600- 18e¥-LR- 10rin. st
DIP_120-600-LR-10min MM
DIP_120-850-LR-10min . msm
DIP_200-400-HR-10rmin, MSM
DIP_300-600-HR-10min, MSM
DIP_CI+ _120-600-LR_10min.msm
; LR_10rmiry, M5
GC_35-

-LR._15min, M3

GC_35-500-LR._30min. MM
GC_50-500-LR._30min, MM
GC_50-500-LR._450%_man_inj_S0rmin.msn
GIC_50-500-LF,_man_inj_30min. msm
GC_50-500-LR._man_inj_S0rmin, MSM
GC_50-500-LR._rman_inj_65Srmin. msm
GIC_50-500-LR._man_inj_S0min. msm
GC_100-180-HR:_10min.msm
GC_100-180-HR._15min.msm

= sc_100-180-HR_20min.msm

GC_35-500-LR_188%] Type: MSM File

0-HR._30min.msm

GC_35-500-LR_18ey| Date Modified: 5/4/2006 12:46 AM )0-HR: _1 Omin,M5M

Size: 1.50 KB

GC_35-500-LR_20eV

0-HR_10mmin, M5

5C_35-500-LR_20min M5M
GC_35-500-LR_2Smin.msm

< I

GC_160-290-HR_15min, M5
GC_160-290-HR_20min. msrm

File: name: |GC_35-SUU-LH_1 Qrrin

Files of type: |MS Procedures

ol
= Do |
=]

Cancel
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Click the “Active Files” button...

...and the active file list opens.
Click Edit>Add Line

Find your directory and enter the name of your file
(preferably including your initials).

Low-resolution GC-MS on JEOL GCMate

GCmatePro 3.0 - Instrument Control

File MWindow Calbration Source Peak  Printia

A M B

TuneMode SIMMode ScanMade  MS Prod

}f*-/_j-lllgﬂ

T -

Inlets DataRed

D0y IN-«% @

lon Source ] lon Fucusing\
Mass Selection

GCmatePro 3.0 - Instrument Control

Ele Edit Window Run Source Printing Help

Ao =@ B Y g

Tune Mode SIMMode ScanMode  MSProc | Active Files Inlets DataRed

}Aooram A Qoo - |- &9 .

Slit Settings I Detector l Inlets l

File | Dese| Client |15 amt. [Inlet | Ms

| Sampler Mo, [Reponts [ Status

DGH1_22Jun2005 50-270_50splt_190in_15min| GC_355
DGHZ_Z21un2006 30-270_G0splt_1 30in_15min| GC_35-5
EM1_Z2Jun2008 120-270_50splt_15min| GC_35-5
EM1 HR Jun2006 i Imif| G I

00-LF_15mmin Tul 2-33 31 Completed

00LF_16min | 1ul 233 32 Completed
00LF_16mn | 1ul 233 33
HR_10min

Create Mew Data File As...

Save jr: |_} Data j 2 ¥ o m-
. 1 JEOL 2_plkFrsn_WCC_Ampa_Flagss
- 1_AkFran_WCC_Ampa_FlagsSe7_41203_8ulp = 2_alkFrn_vCC_ampa_Flagst

1_AlkFryn_WCC_ampa_Flags1234_41203_8ul.Irp
1_AlkFrxn_WCC_aMPA_Flagsg910_41203_8ul.vp
@ 1_AkFran_WCC_SAHA_Flags12345_31803_8ullp
1_AlkFryn_WCC_SaHA_Flagss7a910_31803_5ul.lrp
1_AlkFrsn_WCC_TALA_Flags1235_32103_&ullp
. 1_AlkFrxn_MWCC_TalA_Flagst75910_32103_8ul.lrp
—’) 1_AlkFryn_WCC _wATO_Flagsz345_33103_8ul.Irp
1_AlkFrsn_VCC_WATO_Flagse7891011_33103_8ul.lrp
1_AlkFrxn_MWCC_WOHI_Flags2345_42503_Gul.lrp
- 1_AlkFryn_WCC _WOHI_Flagsarss_42503_5ul.lrp
3%‘; 1_AlkFrxn_WCC_VOHI_Flags12457_31303_8ullrp
- 1_check_column_clearedafterarthropodsiwink.lrp
1_VCC_jdSaha_SELIrp

2 _palkFrzn _WwCC_aAmpa_Flagse
2_plkFrsn_WCC_SAHA_Flagst
2_AkFrsn_¥CC_SAHA_Flagse
2_plkFrom_WCC_TALA_Flagst
2_AkFrsn_YOC_TALA_Flagse
2_AKFrn_¥CC_VATO Flagsz
2_plkFrm_WCC_YATO_Flagse
2_AlkFrsn_YOC_VOHI_Flags2
2_KErsn_YCC_YOHT_Flagsé
2_plkFrn_WCC_VOHI_Flagst
S-Phazosaluphn.lrp
S-Phazosaluphn_HR.Irp
15May2006_35.Irp

N

File name: [Ik-1-234-564

j Save |

Save as type: |Data Files

ﬂ Cancel
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Fill in the form that opens:

File: Clicking on the name re-opens the “Create new
data file as...” dialogue.

Sample Description: This is a pair of text fields, each
256 characters long. The content of the first box is
printed in the plot headers.

Client: Enter you name.

Internal Std Amount: Ignore this one.

Inlet procedure: Click the text box to get a list of GC
methods and select the appropriate method. The
naming convention for inlet procedures is as follows:
The first number is the initial oven temperature; the
second number is the final temperature. An additional
number means that there are two different ramp rates in
the program. The number followed by “split” is the split
ratio. Use lower split ratios for more dilute samples. If
there is a number followed by “inj”, it represents a non-
standard injector temperature (default is 230 °C). Use
lower injector temperatures if your sample is showing
signs of decomposition in the injector. The last number
is the total length of the program in minutes.

Example #1: 120-270_50split_20min starts at 120 °C
and ramps to 270 °C with 50 split in the injector and a
total duration of 20 minutes.

Example #2: 60-100-300_splitless_190inj_45min starts
at 60 °C, heats to 100 °C, changes the ramp rate and
heats to 270 °C. The entire sample volume is pushed
onto the column (splitless injection) with a 190 °C
injector temperature. Program duration is 45 minutes.
MS Procedure: Click the text box to get a list of MS
methods. Select GC_35-500-LR_NNmin, where NN is
the length of your GC method. The length of the GC
method and MS method MUST match each other.
Autosampler Procedure: Click and click cancel to set it
to ‘Current’.

Location: Enter the number of the autosampler position
that holds your sample

Click OK.

3% Data File Description

Digk Space Available 238.24 GBytes

Path/File |

[~ Identical Analyzes

File |Ik.-1-234-568

Sample Deseription [This fine will be printed in the header of the spectiun printout

Thiz ane will not be printed anywhere but iz stored in the file

Client ||van Keresztes

Intemal Std Amount |q micrograms [pg) j Sample Size
Type [dniitz
Inlet Procedure |120-270_1 Dsplit_10min [Soid =] [mirograms =]
M5 Procedure [GC_100-120-HR_10min See [

Autosampler Procedure |1, 2.3.3

Location |34

Post Acquizition Feport |

(o ]

Cancel ‘

Status Feady -

Comment

[~ Email Data File to J

The “Create new data file as...” dialogue opens again. If you want to run more than one experiment, enter the name for the next sample.

Otherwise, Click Cancel to close it.

Low-resolution GC-MS on JEOL GCMate
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There should be a new line(s) at the end of the active
file list corresponding to the analysis (analyses) you just
set up. Double check that everything is set up the way
anted it. If it isn’t, double click the line to bring up the
“Data File Description” dialogue. To remove an analysis
from the queue, left click the file name so that the name
is highlighted with a dashed line, then right click and
select “Delete Line” from the dropdown list

If everything is fine press the green “play” button to start
the data acquisition...

...which switches you over to “Real Time Display”
mode.

The status bar tells you what the instrument is doing.
Initially, it will likely tell you that it's “Waiting for Inlet T =
...”. Once the GC is ready the autosampler will inject
your sample and the MS will turn on automatically after
a 3.5 minute solvent delay.

If you changed your mind, click the “stop” button and
click “Yes” when asked if you want to cancel the
injection.

After the injection has been made, you must wait until
the GC program is complete before you can do anything
else.

If you set up multiple analyses they will run
automatically in the order that they appear in the active
file list. To change the order of the samples, left click on
the line you want to move, then right click and select
“Move Line” from the dropdown list. Click the line above
which you wish to insert the line you are moving.

Low-resolution GC-MS on JEOL GCMate

GCmatePro 3.0 - Instrument Control

Eile Edit ‘Window PRun Source Printing Help

N Mmoo e 9 B

Tune Mode SIMMode ScanMode MSProc | Active Files Inlets DataRed

Y promiga D0 My - |- &9 @

File [ Desc] Client [15amt_ Tirlet [ Ms [Sampler[Mo. [Reports [Status
DGHT_Z2)unz006 50-270_G0splt_190in,_15min GL_35-500-LF_15min | 1ul 2-33 o1 Completed
DGHZ_22)un2006 50-270_50split_130ini_15min GC_35-500-LA_15min Tul 233 32 Completed
EM1_22JunZ008 120-270_50split_15min’ GC_35-500-LA_15min Tul_2-33 33 Completed
EM1_HR_22Jun2006 | - 33 Completed
1K-1-234-567 01 D0zplit_T0min| G

£ GCmatePro 3.0 - Instrument Control

File Window Run Source Printing Help

# & HE 9 &

M3 Proc  Active Files | Real Time Inlets DataRed

¥ Loramadps 000 My -V | s |

| 1K-1-234-567 I [I Client:

Waiting for Inlet T = 120 r

B2 GCmatePro 3.0 - instrument Control

File Edit Window Run Source Printing Help

Al M W =@ ki@ &

TuneMode SIMMode ScanMode MSProc |Active Files Inlets DataRed
' . 3 A 7 S
o ryamide 00 dly- QS E
IMoving line 1K-1-234-567. Click on the line above which you wish to insert the line. | cancel | Bt
File: | Desc] Client |15 Amt_ [lnlet M5 | Sampler |No. [Repons [ Status
DGEH1_Z2JunZ006 30-270_80split_190in_15min GC_35-500-LR_15min Tul 233 3 Completed
DGEHZ_22lun2006 30-270_50split_190ini_15min GC_35-500-LR_15min 1u_233 32 Completed
EM1_22Jun2006 120-270_50split_15min GC_35-500-LR_15min Tul_2-3-3 33 Completed
EM1_HR_22lun2008 120-270_10split_10min GC_100-180-HR_10min  1u_2-3-3 33 Completed
1K-1-234-567 i Oug 120-270_10split_10min GC_35-500-LA_10min Tu_233 93 Ready
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